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DS Protein Similarity Search

CAVNRIBY—H Y AOKREAY—EHEI
*Web. A—HILDF—A~R—R &Y% BLAST. gapped-BLAST. PSI-BLAST « Y—hF—T . Ev hF—TI. PS4V V—4, 2 R%EH
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DS CFF
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CIRTHBEEIRILF—RR(TY v k. K& BEF). DelphiTOFEERART VY v IILICEILWTETERR
DS Protein Families

EERFEEERVTE Y NS BOMEICEERERRE £/2F

CRIVFTINY—HFVRTSA AV b

* Aline123;%(ClustalW ()

* Pre-aligned 7’8 7 7 A JLDIBIRT

v —4 Y ROEEER. conservation/N\&—> ETICT 7 2 U — &I\ s B EFER. (AIEERELEEHRBICI>THREEZISR4—1t
DS Protein Health

- Profiles-3DZE{FRA L T &>/ BiEiE %51l
CAVNRIBRER HEVWEFEFERMTOELFEE
DS LigandFit
cAVNNOE U H Y FORMETHEE SE/ SEEICRT
* Cavityf® 3R IC & 2 JEEEBIIRE
CBEREVTHNAILEDAV T+ A—Y 3 Y EHOBRE
CIRF—F )y FEEERVE Ny 2 SRRE/ARE O SELFHE
DS LigScore
HMBERaT7Y»SEHLigScore2Z ZLRIER AT UV JBAEIT 4>/ ULy FOBEEHMIEE R o 7l
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Windowskfg Discovery Studiolc~NJLTHH Y £7 .
Discovery Studiof2Bf4(C A =2 —/\—® [Helpl — [Help Topics] Z&RT 2L TV HNEEIL. NLTEEIRRINET.

Window | Help

Help Topics
Getting Started

-4/28 - 2023-12-29



Discovery Studio MFANDFE|EF

Tl RURARA V4 EBEREICEL & ZOEBOHELHANRRINET.
ZDFRBADOTEBD [Click here forhelpl 20U v 442 L ZNEBICEHTA2NLTEENRRINET.

Run Simulations

These tools work on a single molecule or complex. To

minimize a set of small molecules independently, use
Minimize Ligands.

Calculate Enerey..

=i Clean Geome
T Calculate Enerey

Minimization...

m Calculates single point energy and estimates

entropy using CHARMm. Requires a molecule in the
Use Standard Dyr current window. To process multiple molecules or
equilibrate and pe| SPecify specific parameters, open the Energy
run, which can be | Protocol.

NAMD.
) Click here for help
Standard Dynami
Dynamics (Production)... (
- N w

47050 [Helpl 25V v I T2 LETEANNTHEERTT D ENTEEXT.

Calculate Energ

Parameter Name Parameter Value

Input Typed Molecule laql:laql
Implicit Solvent Model None
Nonbond List Radius 14.0
Electrostatics Automatic
Estimate Entropy False

| Show Parameter Help

[ Run ] [Options v ] [ Cancel ] [ Help

- 5/28 -
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2.1. Discovery Studio Clientd #Z&]]

WindowsIZ A > & b —JL L f=Discovery Studio Client&#2&]L £ 3
Windows 7 DI8&

[RE—F] > [TRTDOTAS S AL] - [BIOVIA] — [Discovery Studio</A\—3>&>]1 #Uv s LET.

Windows 10 D&

[R%4— k1 — [BIOVIAl — [Discovery Studio</\—¥a>&>1 4 Uv s LET.

2017R2DFCENEE IFRDIBEY T .

File Edit View Chemistry Structure Seguence Chart Scripts Tools

Receptor—Lnxand Interactions | Pharmacophores | Small Molecules m S fuct features Q

Window Help

YGew BB E * x o | &

Tools £ | Files 1

Run Simulations

These tools work on a single molecule or complex. To
minimize a set of small molecules independently, use
Minimize Ligands.

Tools

alculate Energ:

Minin n
Use Standard Dynamics Cascade to minimize, equilibrate

and perform an initial dynamics production run, which can be
continued using either CHARMm or NAMD.

Standard Dynamics

Dynamic oduction).

Dynamics (NAMD)
Dynamics (Heating c line)
D
Solvation

Create Pulling Atom Pair

mics (Equilibration)

Steered Molecular Dynamics
Calculate Free Enerey from Steering Forces...
Oalculele Energy (DFT)...

‘UN MM)

Setup Constraints

Calculate Electrostatics

%) Display Style..

[~ DS Welcome 3

P ;
2S BIOVIA | Discovery Studio 2017R2

My Recent Actions

» Minimization..
» Calculate Energy
» Open

» Standard Dynamics Cascade
My Recent Tool Panels

* Run Simulations

» View Interactions

Actions ‘ 4 ‘

Sample Files

Protein Structure

Multiple sequence alignment
Annotated sequence
Pharmacophore model

Ligand structure
small molecule library

»
»
»
N
» Structure based pharmacophore
»
»
» Receptor-ligand complex

N

Bacteriorhodopsin trajectory
My Recent Files

» charmm.log

Data

My Recent Jobs

»

>

e A > Output.log » Minimization
anee Forcefiel
r lE T * laql.dsv Error Oct-2017:29
nalyze Trajectory
* 1aql.pdb > Calculate Energy

o]

Notifications

m

Standard Dynamics Cascade
Oct-23 16:06
Calculate Energy
Oct-23 16:06
Calculate Energy
Oct-23 16:06
Minimization
Error Oct-20 17:27
Calculate Energy

Oct-23 16:06
Minimization

Error Oct-2017:29

Oct-23 16:06

Server: <none>

#7318 [Filel —

2.2. y—/IN\—~DIEHEETE

n+§%/_ 5 Tu-&) I‘- Id:\
7O ETITOWET.

[Exit] ZEIRLTLIEE L.

HEERITT LY —N\OBRENVELCRYET.

* TSUBAMEQH—N\—%FBAT 2158
Discovery StudioDEtE #TSUBAMETREITT 5 L ETEEE -

*PCLTHEZITSHE

Server nametfl(C TNocalhost:9943] # AJJL. OKK 4

HoriEZE

RER. XOEBRDOE S I,

BELTWRIBARRR.

FRE &

QA3DEINEELBA TS L.

BEHATICRELEATAR RSN TONE EL R
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\ Server:localhost:9943M v17.2.0.16349

23. 31 &> AERINAOMERR
TSUBAMEICE &' 1 ¥ LIHREET. RO AT KIck Y. 51 RFIAKREBETEET.

$ lmutil lmstat -S msi -c 27005@lice0,27005@remote,27005@t31dapl

Discovery StudioZ#ZEJL TL\ B Windowsmh D bR T D ENTEET .
[R&— K1 — [BIOVIAl — [Utilities (FLEXIm LMTOOLs)! %% Y v & L TLMTOOLS%#ZEIL. [Server Status! & 7 ®Individual Daemonic
[msil &AJIL [Perform Status Enquiry] 22 Y v 5§32 L5 42 RAFAKRRANRTEINET.

LMTOOLS by Flexera Software LLC - X

File Edit Mode Help
Service /License File I System Settings I Utilities I Start/Stop/Reread Server Status IServer Diags I Config Services I Borrowing I

Helps to monitor the status ofnetwork licensing

Options

Individual Daemon I msi

Perform Status Enquiry |

Individusal Feature l

Server Name |

———————— A
Status

Flexible License Manager status on Fri 35/8/2017 08:57

[Detecting lmgrd processes...]

License server status: 27005@1lice0,27005@remote, 27005@t31dapl .

IUsins License File:
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3.1. HK

Discovery Studio®##{El& 3~ TVisualizer Discovery Studio Client ET{TLET .

-

Discovery Studio Client

=)

File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help

Tools [ Files R ~ | DS Welcome | % 1aql [

Run Simulations “l | o @@ <Cell>

4 [V]g* laql

These tools work on a sinele molecule or complex.
To minimize a set of small molecules

independently, use Minimize Ligands. Jes A

sjes <chan>
Calculate Energy.. Ve W

t+# Glean Geometry 7|9 Hetatm

V]9 Water
v| %, Protein Groups
V| % Ligand Groups

Minimization..

Use Standard Dynamics Cascade to minimize,
equilibrate and perform an initial dynamics
production run, which can be continued using
either GHARMm or NAMD.

Standard Dynamics Cascade..
Dynamics (Production)...
Dynamics (NAMD)..
Advanced

m

Dynamics (Heating or Cooling)...
Dynamics {Equilibration)...
Solvation...

Steered Molecular Dynamics

Create Pulling Atom Pair

Steered Molecular Dynamics...

Calculate Free Energy from Steering Forces..

A

m »

Receptor-Ligand Interactions | Pharmacophores | Small Molecules m My Tools
%

GNew "B REH ® & @ |8 Display Style.. ~ Non-bond Interactions...

Galculate Enerey (DFT).. Fy Index  Name  Visble  Tagged PartialChargeMethod UseResidueTer|
Caleulate Enerey (QM-MM).. 11 lagl V| Yes No MomanyRone True
Minimization (QM-MM)... 4+
Setup Constraints . = 3
Chanee Forcefield ¥ = = = - s s s
——— ~ | \_Molecule /\_Cell /\_AminoAcidChain /\_AminoAcid /\_Atom /\_Chain /\_Residue /\_Group /\_Bond /
Jobs [ n
Protocol Name Saved Status Details Elapsed Time  Start Déte Server Location at-
Calculate Energy No Success -1816.61966 kca 0:00:13 B 10 23 17:08:0 localhost:9943
Minimization No Success -20943.30624 kc 0:00:39 £ 10 20 17:35:3 login0:9943
Calculate Energy No System Error | starting job C9D £ 10 20 17:35:0 login0:9943 i

Server:localhost:9943M v17.2.0.16349

FHRIFEANLTOUTOR—VETEL SV,
Working with Discovery Studio > Working with the client > About the client

3.2. REDHERER UEE

[Edit] — [Preferences]l 22 Y v LET.
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Preferences™ 1« > RUNILE LY ET.

4
=

Undo
Redo

Cut

Copy

Paste

Paste Special...

Delete

Select All
Select...

Invert Selection
Group...

Find...

Add Attribute...
Attributes...

Preferences...

Ctrl+Z
Ctrl+Y

Ctrl+X
Ctrl+C
Ctrl+Vv

Del

Ctrl+A
Ctrl+E

Ctrl+F

File [Edit] View Chemistry Structure S

3

Dvhamice TEauilBrationy .

[Molecule Windowl — [Graphics] Z&RL %7
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- __
Preferences

> General a [Molecule Window
> Files Explorer Note: These preferences change the global settings for the application.
4 Molecule Window To change the settings for your current window use the Display Style dialoe.
Default Layouts
Graphics Projection Quality
Data Table () Orthoeraphic ) Low
Display Styles @ Perspective ) Medium
Lightin i
'ghting 20000 4 ® High
Materials
Stereo ) Ultra-high
> Import Backeround Color, Image
Export _ Line width: 160 |2
Sketch and Clean
guelry Hardware acceleration Rendetuielonlmeve
00ls p - o
o L "] Uge OpenGL Shaders ) Simplified
> Dreiding Minimize
> Sequence Window (] Use fast refresh ® Fast
> Annotation Window LREs e @ Eull
. Charts | Depth cue -
Protocols
Text Window
» Validate Protein Struct . [ Encat ] [ Help ]
< | 1 | »
QK ][ Cancel ][ Apply ]

[Protocols] Tlk. 7B b ALEITORHDEREEITVET. HIZE
LETHFICTI A LI —BPRFEBMEZEETEET. Fxzv IRy I REHSIRVIEE.

E 3

-10/28 -
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-
Preferences

> Import - [Protocols
Export
Sketch and Clean Number of jobs to display 32,000
Query Maximum size for automatically downloading results {(MBE)
Tools [] Close protocal tab on run
» Dreiding Minimize

Use default path to save a job

> Sequence Window —
(] Save password

> Annotation Window

Charts [] Save intermediate files when running protocols
Protocols Server names list containg 10 5 items
Text Window Pipeline Pilot Client Setting

> Validate Protein Struct Path to the Pipeline Pilot client used to view protocols

Build and Edit Nucleic |- OVIA¥Pipeline Pilot Glient 2017 R2¥bin¥Pipeline Pilotexe

> Protein Utilities
Superimpose Proteins
Dendrogram Window

» Evolutionary Trace
Forcefield
Phylogenetics
Ligand Definition

» Define and Edit Bindin

Protein Docking . [ Resst || Hep |
P - -

[ QK ] [ Cancel ] [ Apply ]

3.3. Toolbars D% FE K UNFEER

ToolbarsMEZTE - MEEREITLET. [Viewl — [Toolbars] Z&RT 2 &, EHICAZa—MNRRINET. BRESNEAZ2a—OFTFzv s
BASTVUDREDNIRERTINTVNEHDTY . Kk - IRTRIFENETNOEEERI Y Y ITHILTITAET.
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Chemistry Structure Sequence Chart Scripts Tools Window H

¢ [ Display Style... Ctrl+D W
" Color... *,{,\ Display Style.. Non-bond Intet
Transform » PS Welcome % 1aql £
3 Spin »
L
;‘ Storyboard »
| Clipping Planes...
1 Sterec
§ Tile Molecules in View Ctrl+L
i 2 Full Screen Fi1
: Visibility >
:J v Graphics Ctrl+G
: Hierarchy Ctrl+H
1 v Data Table Ctri+T
N
| Explorers »
. Docks »
: Toolbars » Alignment
l Tool Panels Animation
he Atom Fﬂ Atom Colors
ecular Dynamics.. Atom Display
‘ee Energy from Steering Forces... Chemistry
Dendrogram
:Z::; Eg:nnMM) Search Product Features L
) (OM-MM)_. ; Navigation ]
aints Nucleic Acid Structure Display [
sfield * Protein Structure Display
Elany v Protocols
ctrostatics | @ Query i
Scripting |
me Saved Status Sequence l
e Energy No Success Sketching D
ation No Success v Smart Tools 0
v Standard |
— View
T
v’ Status Bar

- 12/28 -
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B4 MEE T+ LA —DFETE

FHEHERE. #IHAEEE T I My Document > Discovery Studio > ResultsLA TN ICIERENET. REFET LT —ZEEL LWFEIE. Files Explorer
TEEEITLWET.

5l Z 1E. My Documents 7 # LA —[CHT3R 7 + L&A — [Sample! Z{ERF 5158+ Files Explorerd®My DocumentsZi#EIRLT. 5o Y v I LET.
KRENB A=a—DNew Folder&BIRL £ 7

Fies 3 ;

& My Documents

> (&) Deskt Remove Root
> W Samp Set as Default
’ Windo Refresh F5
b £ T3_HS B
> & share Open With y
> k= smbo
> &) Histor] 2€ Cut Ctrl+X
Ff Ccopy Ctrl+C
[ Paste Ctrl+V

New Folder...

72X Delete Del
Rename F2
Properties...

My Documents 7 # LA —Z R L. Sample7 + LA —%BIRL. AU vILET. RRENDA=a—0DSetasDefaultZBIRLET. Th
T. Discovery Studio TERITL &R DIRIFIHLASample 7 # LA —IC78 Y £F .

> () report

> ) SGE

Add Root Node...

Set as Default
Rofrach =1

FIANMD T A NE—ICRESNIETHNLEA—TAAVDEEENEICRYET.
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4.1 B FDIEE

A=a—/\— [File] - [New] — [Molecule Window] %#3iZIRL. ##RIcMolecule Window%F &£ 7.

L e e
File | Edit View Chemistry Structure Sequence Chart Scripts

New | %, Molecule Window
[@ Open... Ctrl+0 | we  protein Sequence Window r
‘ @ Open URL... AT

oy
»

&% Nucleotide Sequence Window

r

Discovery Studio Client

Run Simulations -~

These tools work on a single molecule or complex.
To minimize a set of small molecules
independently, use Minimize Ligands.

Calculate

Clean Geometry
Minimization

Use Standard Dynamics Cascade to minimize,
equilibrate and perform an initial dynamics
production run, which can be continued using
either CHARMm or NAMD.

ndard Dynamics Cascade

Dynamics (Heating or Gooling)

>

s (Equilibration

ation

Steered Molecular Dynamics

z Atom Pair

Steered Molecular Dynamics

Calculate Free Energy from Steering Forces...

Calculate Enerey (DFT)..
(QM-MM)
on (GiM-MM)
Setup Constraints

Change Forcefield

Analyze Trajectory

Calcu

Mini

Calculate Electrostatics X
Jobs [
Protocol Name Saved Status Details Elapsed Time  Start Date Server Location
Calculate Energy No Success -1816.61966 kca 0:00:13 B 10 23 17:08:0 localhost: 9943
Minimization No Success -20943.30624 kc 0:00:39 £ 10 20 17:35:3 login0:9943

[ =NRCN X
File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help
[ Mecromolcoulos MR Receptor-Lisand Interactions | Phormacophores | Small Moleoulos | X-ray [ My Tools Q
“aNen B H x %) Display Style.. ~
Tools £ | Files n |ml &

Server:localhost:9943M v17.2.0.16349 I

WMERY — LA Toolbars[CRRENTWRWESIE. [Viewl — [Toolbars] O—EMSBIRL £ 7.
AEITIERDY —ILEFERLET.

+ View Tools

Select R RFCHEEFEBIRLET. BRULEEDFEETRRSNET.

+ Sketching Tools

- 14/28 -
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Sketch ¥ EFE—o—oHH LFTATEBELET.

>
Chain % : KB £ 15>R F OECFIAL £ 7.

,‘_’
Ring & ImRiEEE 6 >N FOBEICFIALET.

+ Chemistry tools

Shows/Add Hydrogens ' = : kEEFEMMLET.

Single Bond . Double Bond + Aromatic Bond + Triple Bond HEEHREEELET.

-
Periodic Table EEAROFA LM BT SEFEBERLET.

Clean Geometry ~* : HiiE % b HIZEE - B L £ F.

411. ROEL Y DIBER

FlELT RYEYDIEBE. RVEVHLMBPFADEEICOVT. REALET.
RingZ7A4a>%&oUvws¥ae. BESOHEBEBET—NCIRYET.

Z\&| T

Z OIKEETMolecule Window EC—EAE S Y v I LET. RFEOFEFHLRIREBENMERSINET.

TIANPTREFES LB >TLWETOT. HEKRELZELET.

Select R AL TETCORZEEFEERLET. Cl+ATHLNWTT

- 15/28 -

Discovery Studio MIFBDF5|E

2023-12-29



Discovery Studio MIFBDF5|E

AromaticBond&® 2 Y v o L %7,

RISKEEFEMMLET. AddHydrogensRE> %7V v I LET. THEUTOLS ICKEREFIRERFICHMLET.
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UETRYE DEBEIFIETTT .

41.2. Ry LV FEEDETIVIBE
B LRV EY ER—RIC. HORFADEBEFEICOWVWT, HBALEY. KRETIE. 7/ —IL(COHS0H)EHEHELET.

KERFETEERLETS.
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Periodic Table 22 U w 4 LE¥. ¥ 5 &Change Elementd 4 7RI HNRREINDNDT. [0l ZBIRLOKEI YUY ILET.

,
e o R ==

Group
14 0
H | 24 38 44 BA  BA  T7A | He
Li || Be B (] N a F Ne
Na | Meg| 3B 4B 5B 6B 7B 8 1B 2B [ &l |18 || P S |Gl || Ar

Ca | |Sc || Ti Yo Cr  Mn Cu
WBOL
wmﬁllﬂlﬂm

Ac

HEEER
=

F

=2 e el

QK H Cancel H Help ‘

KERFHBRERFICESBEDYET.
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Add HydrogensR&> %2V v o § 5 &, Bl BERFICKBERFATMENET.
NETTz/—pMERENEL Tz

42. RTF KRDIEE

A=a—/X\—® [Filel - Newl — ['Molecule Windowl %i&iRL. #f#RIcMolecule WindowZFE£ 7.
[Macromolecules] Tool Set#3&RL. [Tools Explorer] @ [Build and Edit Protein] 24 Vv LTERHEAL %7 .

- 19/28 - 2023-12-29
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File Edit View Chemistry Structure Sequence

A OHMH (% % L 1 T s R €

N2 2 & TIDO

Macromolecules BTN dGNNEE G BEETT

G BB EH O X2F0 & |

Tools ) | Files [ B [em

| Build and Edit Nucleic Acid 2| | [

Build and Edit Protein 2([]

Build Action: Create/Grow ~
Conformation: Extended ~

Apply Conformation

Ala Are Asn Asp Cys

Glh  Glu Gly His e

leu Lys Met Phe Pro

Ser  Thr Trp Twr Val

Mse Cse O Ptr  Sep

Tpo Tys &b Pca Specify..
Modify Structure

L/D Conversion Cap Termini...

Define Amino Acid...

Create Structure from Sequence

m

Query Online Databases |

Ao . -

Build Action#® Create/Grow. Conformation A'Extended& 7> TWBHZ & &EEL £ T
RERTFROVP—I T REANLET. ANNICIE. BEOFENHYET.

1REBRAITERYEEMT S
Choose Amino ACidD3XNFRIED T Z/BE I Vv /T3 LZDORENEMENET.

CBEERTFRI—ITVREANTD
Choose Amino Acid®Specify 22 ) v 2 LU TOEMRICKY £7.

Enter an Amino Acic

[P-Ianine - &
Specify Sequence

@ One Letter Code () Three Letter Name

[ Cancel ][ Help

TNETVYRMHLEREZBIRT 50 THXRIMRY SRCEBANT S ETHELEE LRI E—HETHETHENTEET,
FHHllEHelpE CBE L EE L.
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Macromolecules tools > Macromolecules tool panels > Build and Edit Protein tools > How to use the Build and Edit Protein tools

4.3. T—AR—ZAM 5 DIEBEDOEYIA

Discovery Studio % 28T HPCA A > & —F v M ICIERTE 5184, RCSB PDB ®NCBIIC & Y EETRAMEIN TN S 2> /XS BORBOESESR
AL ENTEET.
[Filel — TOpen URL] %i&RL. OpenURLY 1« ~ kY EHEENIL £ T

MDl ICEEL WA Y O EE B OIDE.  [Sitel ICHEGRZIEEL TOpent s Y v o ¥ 5 & ZDtEED Molecule WindowsIZRmEh
£7.

http://files rcsb ore/download/ 1crm pdb

Generate URL using

ID: lcrn Site: [Default PDB Structures

Qpen ][ Cancel ][ Help

-
| I Discovery Studio Clien

File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help

R <€ @ax-

A A" Ry Y0 Y@
N2 & TEI

ww Receptor—Ligand Interactions | Pharmacophores | Small Molecules m My Tools QL

4 New v B [ E - P 5 \% Display Style.. ¥ Non-bond Interactions.. v
Tools £ | Files R | tem B
Build and Edit Nucleic Acid 1 4 U@ <Cell> ~
Build and Edit Protein 4 [7]g% 1CRN
Query Online Databases 4 Viea A
Protein Report vl A¢ THR1
9 0 THR2
Protein Report vl A¢ CYS3 E
To visually inspect the properties of a V| s CYS4
protein structure generate a 7] & PROS
Hydrophobicity Plot or a Ramachandran |
Plot. V| A¢ SER6
Prepare Protein < N ILE7
V| ¢ VAL8
Search Sequences by Similarity 7| A¢ ALAS
Alien Sequences and Structures 7| A ARG10
fnalyze Sequences V| A SER11
Analyze Protein Conservation Pattern V| A ASN12
Superimpose Proteins v| ¢ PHE13
Create Homology Models v /:% ASN14
Search Side-Chain Rotamers 7l s VALLS
Minimize and Refine Protein vl ) CYS16
V| ¢ ARG17
Model Antibody V| ,¢ LEU1B
Dock and Analyze Protein Complexes 7] A¢ PRO19
Desien Protein 7] A GLY20 -
Predict Protein Ageregation < m ’

AV

Analyze Transmembrane Proteins

-

Name ID Visible Color Parent Molecule FullName Type PDB Name Insertion Code Hydrophobicity

1 THR1 1 V|Yes O ) 1GRN &Thrl Threonine THR =07

2 THR2 2 V|Yes D A 1GRN AThr2 Threonine THR -07

3 CYs3 3 v|Yes D A 1CGRN ACys3 Cysteine CYS 25

4 CYsé 4 v Yes O ) 1GRN ACysd Cysteine CYS 25

5 _PROS 5 JIYes 1 A 1CRN A:Pro5 Proline  PRO -16 -
< n »

Molecule /\_Cell AminoAcidChain AminoAcid Atom Bond /\_Grouj

Server:localhost:9943M v17.2.0.16349
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BiERY R RRENET. BRERELTELEWESE. Molecule WindowsD2WERDTHZ U w & L. Display Style®ZBIRLEY.  FflE

Y L= %) Display Style.. 5509

Display Stylew « >~ RUARHEET.

Protein® 7 &R &. Display style%Solid ribbonm 5O0ffICZEEL £7 .
Atom#& &R &, LineZiEIRL. ApplyES Y v I LET.
BENSAVRRICEESNET.

Macromolecules®Protein Report%# 2 Y v 435 L. ZOEEICAT 2 ERPIRTEINET.
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[~ 1ern Protein Report [£3 a -

Protein Report for 1crn

Basic Information for Molecule 1CRN

Cell Space Group: 4 (P21 B-Unique Choice: 1)
Parameters: 40.96 18.65 22.52 90.0 90.8 90.0
Crystallographic Resolution: 1.50 angstroms
Molecular Weight of Protein: 4730.52

Amino Acid Chain Names: A

Number of Amino Acids: 46

Experimental pH: not reported

Amino Acid Sequence from Available Structure

Chain A
TTCCPSIVAR SNFNVCRLPG TPEAICATYT GCIIIPGATC PGDY

Comparison of actual sequence versus PDB SEQRES records
No missing residues found within chain A

Biomolecule Generation

THE AUTHOR PROVIDED AND/OR PROGRAM

GENERATED ASSEMBLY INFORMATION FOR THE STRUCTUR
IN

THIS ENTRY. THE REMARK MAY ALSO PROVIDE INFORMATIC
ON

BURIED SURFACE AREA.

To generate the biomolecule(s), use Structure/Superimpose/Apply
Transformation Matrix:

BIOMOLECULE: 1

Apply matrix BIOMT_1 to chain(s): A

Discovery Studio RN F5|E

T—AR—ZHBEIF L EBEEXIRERBERNICK YIS ShIEBETH Y. KRIHMIMLTOLERA. Tl THUNSENRTVZIEGHH

YET. £07=®. FTEZITSAIIC. Add HydrogenT/AZRZMML Y. THMZENY RV Y T 2 MNIENKETT .
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P

51. 4> N/ BoigEmELETE

COEITIE. RCSBPDBAHEEL fclernniBiEHEILE#ITVWET .

=3 lenEMAEET.

Display StyleZLinelcZEL £3

’ | tern (£ ‘
4 [V H <Cell>
4 [7]g* 1CRN

4

Name
THR1
THR2
CY33
CYS4
PROS

AN B W

Jeo A
v/ ¢ THR1
7 ¢ THR2
v A ¢ CYS3
v M CYS4
v| A PROS
7| ¢ SER6
v\ ¢ ILE7
v| ¢ VALS
v| ¢ ALAS
| ¢ ARG10
vl A¢ SER11
vl ¢ ASN12
v| ¢ PHEL3
vl ¢ ASN14
v| ¢ VAL15
vl ¢ CYS16
vl ¢ ARG17
vl ¢ LEU18
J| A¢ PRO19
vl A ¢ GLY20

1D Visible
v|Yes
J|Yes
J|Yes
V| Yes
lYes

s O R —

m

1

Color

100080

I

Parent
f

> > > >

Molecule

1GRN
1GRN
1GRN
1CRN
ICRN

AY

FullName

A:Thrl
#:Thr2
ACysd
ACysd
A:Prob

\ Molecule /\_Cell \_AminoAcidChain _/\_AminoAcid /\_Atom /\_Bond /\_Group

Add hydrogen R&> %4 Uw s LT KEE[MLET.
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Type
Threonine
Threonine
Cysteine
Cysteine
Proline

PDB Name
THR
THR
CYs
CYsS
PRO

Insertion Code

Hydrophobicity
-07

=07

25

25

-16

-
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l % fom (£ I
4 [V E <Cell> -
4 [7]g~ 1CRN
a4 Ve A
vl A¢ THR1
v ¢ THR2
vl A¢ CYS3
vl A ¢ CYS4
v| A¢ PROS
7| A¢ SER6
| ¢ ILE7
7] M VALS
| A ¢ ALAS
7| ¢ ARG10
7] ¢ SER11
7] A¢ ASN12
7| ,¢ PHE13
7] A¢ ASN14
vl ¢ VALLS
v| A¢ CYS16
| A ¢ ARG17
v| ¢ LEU18
v| ¢ PRO19
vl A GLY20

m

1

Name ID Visible Color Parent

THR1 V| Yes A
THR2 V| Yes
CYS3 J|Yes
CYS4 J|Yes
PROS JYes

AN bW N
o o R —
100800
> > >

"

Molecule
1CRN
1CRN
1CRN
1CRN
1CRN

FullName

#:Thrl
#:Thr2
ACysd
ACysd
A:Prob

\Molecule /\_Cell_/\_AminoAcidChain_/\_ Amino#cid /\_Atom /\_Bond /\_Group J

RICHIBEERD A1 TERELET.

[Simulation] Tool SetZiEIRL. [Tools] Explorer® [Change Forcefield] 4 U v 4 L TCRBEL XY,

Forcefield K UPartial Charge£3%EL =7

Type
Threonine
Threonine
Cysteine
Cysteine
Proline

PDB Name
THR
THR
CYS
GCYS
PRO

Insertion Code

Discovery Studio MFANDFE|EF

Hydrophobicity
=07

=07

25

25

-16

-

Z DOffITIE. Forcefield ICTCHARMm#%. Partial Chargel[CMomany-Rone%3&RL £ 3. BIRL7=5. Apply Forcefield® 4 Vv 4 LTHEAL T,

Macromolecules B0 4001

UNew v 2 *
Tools ] | Files n

Run Simulations

P

Setup Constraints

Chanee Forcefield

Forcefield: CHARMm «

Partial Charge: Momany-Rone
Apply Forcefield

charmm36 Forcefield

Assign Forcefield..

JRIZ. Tools Explorer@Run Simulations% BRI L+ Tools > Minimization 4 Y v ¥ L. Minimization¥4 70/ #M&E £ 7.
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Macromolecules m Req

Nw v B REH & * X
Tools &) | Files [ n ’r

Run Simulations ] -

These tools work on a single
maolecule or complex. To minimize a
set of emall molecules independently,
use Minimize Ligands.

Tools

Calculate Enerey...
=i Clean Geometry
Minimization...

Use Standard Dynamics Cascade to
minimize, equilibrate and perform an

Parameter Name Parameter Value

Input Typed Molecule 1crn:1CRN
Minimization

Implicit Solvent Model None

Nonbond List Radius 14.0
Electrostatics Automatic
Advanced

["] Show Parameter Help
[ Run ] [OptionSV ] [ Cancel ] [ Help

BINS A—AR—OiiAE. Helpx TEEBLEEL.

ZOFITIH T7FIMDEFRNEI Uy I LET. SFTEAIRIBSN. UTOD 1> RUARRENET.
Minimizine: 1CRN
] Details

\ Background] [ Stop

HE# (FJobs Explorer CHESRTE £ 7.
HENRTT2LEUTOLSICRRENETDT. OKES Yy I LET.
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BIOVIA Discovery St

Minimization
CHARMm Energy = -2260.22878. For individual energy components, see the molecule properties in the table.

[ QK H Report ]

5.2. T E#ER OHERR

HEEERITLTLAME. #ERIX. Setasdefaut TIEEL 7 )4 —IC. "TO baLZ _ FRE B EWS 74 LA —ZBTIER SN E T,
{ER SN T # LA —DO0utput 7 # LA — [CETERER T 7 1 LHMER S ET.

4 ) Minimization_2017_10_26_143713_457

4 &3 Input

1CRN.dsv

8@ Protocol.pr_xml
4 {3 Output

- () Report

1CRN.mol2

El| charmm.leg

| Output.log

1 Report.htm

ViewResults.ds_pl

HIERE. FRALETo baLicEYEDLYET.
ZOFITIH. FTRICRT 7 7 AINMERENET.

TrANE RE

charmm.log CHARMMIC & 25T E#ER

1CRN.mol2 MinimizationlC & » TELNIIBIET 7 1)L

Output.log FEY—/AL0aATY REZDOBREODNTEREFELETI 7ML

IS —RTLIEBRE A7 71V ESBL. MESERHELTIESY

Report.htm HEEREEDEHTMUEXO 7 7 1L

SHEERIE. Jobs Explorer SIFUNHET Z & HAIEETT .

Jobs ‘
Protocol Name Saved Status Details Elapsed Time
4 Minimization []No Success -2260.22878 kca 0:00:57

View Results
Minimized Molecule
CHARMm Log File

Report
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